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1. About SEC Spectra 

SEC Spectra is a software program for the portable spectrometers system “SEC2020 Spectrometer 

system”. It offers a wide variety of optical measurements including spectrum, absorbance, transmittance, 

reflectance, Relative Irradiance, and concentration. 
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2. Minimum System Requirements 

Before installing SEC Spectra, ensure that your computer meets the following minimum requirements: 

Minimum System Requirements 

Processor 1 GHz or higher 

RAM 4 GB or higher 

Hard Disk 100 MB or higher 

Screen Resolution 1024 x 768 or higher 

Operating System Windows 10, Windows 11 

Software Microsoft .NET Framework 3.5* 

 

IMPORTANT： Versions other than Microsoft .NET Framework 3.5 will not work. 
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3. Installing SEC Spectra 

3-1. Before Installation 

Before installing SEC Spectra, ensure that you have the administrator privilege to the computer. 

Note: If your PC does not have the Windows feature "Microsoft .NET Framework 3.5" installed, please 

install it before installing SEC Spectra. The detailed procedure is described in "3-5. Installing .NET 

Framework 3.5 ". 

The spectrometer should not be connected to the PC during installation and uninstallation of SEC 

Spectra. 

3-2. Installing SEC Spectra 

Insert the USB memory supplied with the device into your PC. There are two folders in the USB 

memory, "Manual" and "SEC Spectra _ ** (software installer)". Open the "SEC Spectra_**" folder and 

double-click "setup.exe" to start the program installation.  

The setup wizard starts up. On the Welcome screen(Figure 3-1), click Next to proceed the installation.  

 

Figure 3-1. Setup Wizard -- Welcome 
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On the Select Installation Folder screen, select Everyone or Just me and click Next. 

 

Figure 3-2. Setup Wizard -- Select Installation Folder 

On the Confirm Installation screen, click Next.  

 

Figure 3-3. Setup Wizard -- Installation Complete 
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If a Windows security alert is displayed, select Run to proceed. Program will execute the installation, 

please wait for a while.  

 

Figure 3-4. Setup Wizard -- Installation Complete 

When you see the Installation Complete window(Figure 3-5), it means that SEC Spectra has been 

successfully installed. Click Close to finish.  

 

Figure 3-5. Setup Wizard -- Installation Complete 
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3-3. Installing Device Driver 

Normally, device drivers for supported spectrometers will be installed with SEC Spectra as part of the 

setup process. The device is usually displayed as "Taurus" in Device Manager (Figure 3-6).  

 

Figure 3-6. Taurus is displayed correctly in Device Manager 

The driver may not be installed due to unexpected errors. Figure 3-7 shows an example when the 

device is not recognized correctly. It will be recognized as a device called "SCAN" with a "!" mark. 

 

Figure 3-7. when the device is not recognized correctly 

In that case, you need to install the driver manually.  
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Follow the steps below to manually install the driver: 

Connect the spectrometer to a computer and start "Device Manager". If you see an unknown icon like 

"SCAN" as shown in Figure 3-7, right click on it and select "Update driver". 

 

Figure 3-8. Select "Update driver" in Device Manager 

Select "Browse my computer for driver software" and manually specify the folder containing the 

"TAURUS" device driver and update the driver. 

 

Figure 3-9. Select "Browse my computer for driver software" in Update Drivers  
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After you have specified the path, click Next to finish driver installation. 

 

Figure 3-10. Manually specifying the location of drivers on 64-bit Windows 

Files for these drivers will be copied to the "Driver" folder under the installation path for SEC Spectra 

during the setup. The default path will be: 

C:¥Program Files¥ALS¥SEC Spectra¥Driver¥Taurus    (32-bit systems) 

C:¥Program Files (x86)¥ALS¥ SEC Spectra ¥Driver¥Taurus  (64-bit systems) 

When the driver is updated successfully, the following screen will be displayed, and click "Close" to 

complete the manual installation of the driver. 

 

Figure 3-11. Screen when the driver was successfully updated 

If you need more detailed explanation, please contact us (16. Contact Information). 
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3-4. Removing SEC Spectra 

If you need to remove SEC Spectra, go to the Control Panel and follow the instructions below: 

Open the Control Panel. Navigate to Programs and then Programs and Features. Select SEC Spectra 

from the list, and then click Uninstall. The system will ask you to confirm the removal. After the 

confirmation, you will see a message box showing the removal progress. When it is finished, this 

message box will close. 

 

Figure 3-12. The system is removing SEC Spectra (on Windows 10 systems) 

3-5. Installing .NET Framework 3.5 

Note: If the Windows function .NET Framework 3.5 is not installed on your computer, SEC Spectra 

cannot be installed and executed normally.  

3-5-1. Online Installation 
If your PC is connected to the network, open the "DotNetFX35" folder in the USB memory, click on the 

file "dotnetfx35.exe", and follow the on-screen instructions to install the .NET Framework 3.5. 

 

Figure 3-13. Installing .NET Framework 3.5 components 

After the installation is complete, click Close to finish the installation. 
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Figure 3-14. .NET Framework 3.5 installation complete 

3-5-2. Offline Installation 
Online installation is recommended. If your PC is not connected to the network, you can try offline 

installation of .NET Framework 3.5 by following method.  

① Open the "DotNetFX35"--"OffLine NET35" folder in the USB memory and copy the file "netfx3.cab" 

to the Windows system folder (C: ¥ Windows). If the message "Administrator privileges are required" 

is displayed *, click Continue. 

 

Figure 3-15. Copy files into a Windows system folder 

 

Figure 3-16. Click "Continue" 

Note: If you have any questions about "Administrator authority", please contact your system administor. 

  

https://www.als-japan.com/


 SEC Spectra User's Guide 3. Installing SEC Spectra 

https://www.als-japan.com  14 

② Right-click the file "OffLine Install NET35.bat" in the "OffLine NET35" folder and select Edit. 

 

Figure 3-17. Open file from editCopy the second line. 

 

Figure 3-18. Copy the second line. 

③ Right click on "Start " icon , click on "Command Prompt (Admin)". 

 
Figure 3-19. Open "Command Prompt" 
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④ The "Administrator: Command Prompt" window will open. 

 
Figure 3-20. "Administrator: Command Prompt" screen 

⑤ Paste the content copied in ③ after "C: ¥ WINDOWS ¥ system32>". Press Enter key to install. 

 

Figure 3-21. "Administrator: Command Prompt" execution screen 

⑥ The message "Operation completed successfully." is displayed and the offline installation is complete. 

Close the screen and exit. 

⑦ Now, you can install SEC Spectra software. 

 

Note: Please also refer to the official Microsoft website for installing .NET Framework 3.5. 
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4. Getting Started with SEC Spectra 

4-1. Starting SEC Spectra 

A shortcut is created on your desktop when the SEC Spectra is installed. 

 

Figure 4-1. SEC Spectra program shortcut on the desktop 

Double-click the shortcut to launch the SEC Spectra. 

4-1-1. If you connect the spectrometer first… 

If you connect the spectrometer to your computer before starting SEC Spectra, the Spectrum_0 will be 

displayed automatically under the default settings of the connected spectrometer. 

 

Figure 4-2. The spectrometer is connected when the SEC Spectra is started 
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4-1-2. If the spectrometer is not connected 

When the spectrometer is not connected, after starting the program, the following screen will be 

displayed.  

 

Figure 4-3. The spectrometer is not connected when the SEC Spectra is started 

Next, connect the spectrometer to the computer. SEC Spectra initializes the device. Measurement is 

possible when initialization is completed. When the following screen appears, it means that SEC Spectra 

is ready for measurement. 

 

Figure 4-4. SEC Spectra is ready for measurement
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5. Spectrum Measurement 

SEC Spectra supports a wide range of measurements using the SEC2020 spectrometer system, 

including Spectrum, Absorbance, Transmittance, Reflectance, Concentration and Relative Irradiance. All 

measurements start with a Spectrum measurement. This chapter describes how to create basic 

Spectrum measurements. The following chapters describe other measurement methods based on the 

Spectrum measurements in this chapter. 

5-1. Before the Measurement 

Before starting various measurements, you should set the measurement equipment. When measuring 

absorbance, secure the spectrometer, light source and cuvette holder on the platform,  and connect a 

fiber collimator between the spectrometer and the cuvette holder. For details of the method of setting 

the measuring device, please refer to "SEC2020 Spectrometer System User's Guide - Device -". 

5-2. Creating a Spectrum Measurement 

To create a spectrum measurement, select Spectrum from the Measurement menu to open the New 

Spectrum window, as shown in the following: 

 

Figure 5-1. Selecting Spectrum from the Measurement menu 

 

Note: If you start the SEC Spectra software with the spectrometer connected to your PC, a spectrum 

measurement will be created automatically. Refer to "4-1-1. If you connect the spectrometer first…". 
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On the New Spectrum--Live Spectrum Settings window, select a source device (identified by its serial 

number). Then, enter an integration time (default: 50 ms, i.e. the exposure time for the light sensor) and 

a wavelength range to display on the X-axis (default: 200 nm~1025 nm, the range in the parentheses 

indicates the range supported by the selected device).  

Then, click Next. 

 

Figure 5-2. New Spectrum - Live Spectrum Settings  
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On the Display Settings window, specify whether to display the new spectrum curve in a new or an 

existing window. If this is the first spectrum measurement you create, you can only select a new window. 

This window also allows you to specify a name for the window, as well as a title and a color for the 

spectrum curve.  

To specify a color, click the color patch to the right of Graph Color and select the desired color. 

You may simply leave the default names unchanged. When all settings are done, click OK.  

 

Figure 5-3. New Spectrum - Display Settings 
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SEC Spectra will display the newly created spectrum measurement as follows: 

 

Figure 5-4. Newly created spectrum measurement (Spectrum_0) 

5-3. Change Spectrum Acquisition Settings 

There are several setting icons related to spectrum acquisition in the "Quick Adjustment Field" below 

the main menu. You can adjust the data acquisition settings (Integration time, Average, Boxcar). For the 

functions of other icons, please refer to the detailed explanation in "14-5. Quick Adjustment Field". 

 
Figure 5-5. Icons related to spectrum acquisition 

Integration time 

Adjust the exposure time of the sensor. The higher the value, the greater the Intensity (Y-axis value) 

displayed in the Spectrum graph. 

Average 

Set the number of scans to calculate the average value. The higher the value, the lower the variation of 

the curve.  

Boxcar 

Smooths the spectrum curve. Sets the number of data to be used for the moving average calculation. 

The higher the value, the smoother the curve and the less prominent the changes. 
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5-4. Graph Toolbar 

The toolbar icons are located at the top of the spectrum diagram. It can be adjusted to the optimum 

scale for each measurement to display the spectrum properly. See the detailed explanation in "14-6. 

Graph Toolbar Icons". 

 

Figure 5-6. Graph toolcar icons 

5-5. Show Spectrum Data 

Press the Show Spectrum Data icon on the toolbar to show or hide the window. For details, 

please refer to "14-7. Spectrum Data Pane". 

5-6. Saving a Spectrum 

If you want to save the spectrum to a file for future reference, you can press the Save selected 

spectrum as ... icon  on the toolbar. 

In addition to the Save selected spectrum as ... icon on the toolbar, you can also save the spectrum 

curve from the spectrum data pane. For details, refer to "14-8. Saving Currrent Spectrum" . 

5-7. Loading Saved Spectrum 

You can load a previously saved spectrum curve (extension .sps) and analyze the data on the software 

or compare it with the current spectrum curve. For details, refer to " 14-1-1. Open Spectrum File". 

5-8. Print and Preview of Spectrum 

If you want to print the current spectrum, use the Print Preview  and Print  icons on the 

toolbar at the top of the spectrum diagram. Please refer to "14-9-3. Print Preview and Print" for further 

information. 
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6. Absorbance Measurement 

Absorbance measurement using the SEC2020 spectrometer system and SEC Spectra is calculated from 

the spectrum of light that has passed through the reference object (inject blank solvent into the cuvette) 

and the object to be measured (inject sample solution into the cuvette). Therefore, to measure the 

absorbance, first measure the transmitted light spectrum of the reference object (baseline 

measurement), then set the object to be measured and measure the transmitted light. When the 

measurement is completed, the program automatically calculates the absorbance spectrum.  

6-1. Creating an Absorbance Measurement 

For the measurement of the absorbance, select Absorbance from the Measurement menu and open 

the New Absorbance Measurement window, as shown below:  

 

Figure 6-1. Selecting Absorbance from the Measurement menu 

6-1-1. Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial number). Then, 

click Next. 

 

Figure 6-2. New Absorbance Measurement - Source Device 

https://www.als-japan.com/


 SEC Spectra User's Guide 6. Absorbance Measurement 

https://www.als-japan.com  24 

6-1-2. Setting Acquisition Parameters 
Set the data acquisition related parameters on the next screen. 

 

Figure 6-3. New Absorbance Measurement - Acquisition Parameters 

Specifying Integration Time 

Then specify the integration time (sensor exposure time) on the Acquisition Parameters window. In 

the program, the default integration time is set automatically when the window is opened. Adjust the 

integration time while referring to the preview at the bottom of the screen as necessary. The preview 

will change as you adjusted, so set the peak value within the Suggested peak value range on the window. 

In figure 6-3, the peak value is set within the range of 40000-60000. 

If the adjustment does not work, you can press Auto Configuration to set it automatically.   
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Setting Smoothing 

You can also choose whether to smooth out the curve. Specify the number of scans to calculate the 

average value for Number of scans to average. This makes it possible to reduce curvature fluctuation 

more than a single data acquisition. In the Boxcar width, specify the number of data used for moving 

average calculation. This smooths out the sharp variations on the curve: the bigger the Boxcar width of, 

the smoother the curve. The following figure demonstrates the smoothing effect when Boxcar width is 

10 (maximum value). Compare it with the original Figure 6-3 without smoothing. 

 

Figure 6-4. Acquisition Parameters - the smoothing effect 

Note: Even if the Intensity is within the range due to the smoothing, overloading will occur if the 

pre-smoothing value exceeds the range. If the Boxcar width value is set too high, the resolution will 

decrease and it will not be possible to separate adjacent peaks, so set an appropriate value for your 

experiment. 

After setting all the data acquisition parameters, click Next.  
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6-1-3. Setting Reference Spectrum 

Next, you need to set transmitted light spectrum of the reference material (Reference Spectrum), 

which is basically the spectrum of the light source before set the test object in place. Here, you can click 

on the color patch on the window to acquire the live spectrum as the reference. Or, if you previously 

saved the reference spectrum file you can read it using the Browse button. In this example, the current 

light source is being read as a reference spectrum (as such, please don't put the test object in place). 

Once the reference spectrum is captured, you can check the spectral data in the preview at the bottom 

of the screen. Then click Next. 

 

Figure 6-5. New Absorbance Measurement - Reference Spectrum 
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6-1-4. Setting Dark Spectrum 

After setting the reference spectrum, set the measurement value when light sensor is not exposed to 

light to establish a baseline, i.e. the "dark spectrum." So, please cut off or block the light source which is 

connected to the spectrometer. Then, click on the black-and-white patch on the window to acquire the 

dark spectrum. 

If the "Lamp Control" function of the software is activated (see "14-2-3. Lamp Control"), check on 

Shutter (light blocked), the shutter of the light source operates to block light. If unchecked, the optical 

path will open. If you check on Shutter (light blocked) and press Next, the light source control will be 

released, but to prevent malfunction, it is recommended to manually uncheck it and then press Next. 

 

Figure 6-6. New Absorbance Measurement - Dark Spectrum 

The default value of Number of scan to average is 1, but you can also set it for multiple acquisitions. In 

the example here, 10 is used, instead of the default 1. Once the dark spectrum is acquired, you can 

confirm the acquired spectrum in the preview at the lower half of the window. Also, "Acquiring Dark 

Spectrum ..." is displayed while acquiring the dark spectrum.  

https://www.als-japan.com/


 SEC Spectra User's Guide 6. Absorbance Measurement 

https://www.als-japan.com  28 

Other than actually acquired dark spectrum, it is also possible to use the default dark spectrum, or to 

use a previously saved dark spectrum file. The default dark spectrum is for test purposes only, please be 

carefully when using. The following figure shows the case when Use default dark spectrum is selected. 

Note: The default dark spectrum is for testing purposes only and should be used with caution. 

Once the dark spectrum is set, click Next. 

6-1-5. Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum title and a 

color for the graph. To specify the color, you can click on the color patch and select the desired color 

from the palette. 

 

Figure 6-7. New Absorbance Measurement - Display Settings  
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When you finish setting the display, click OK. The measurement graph is displayed as shown below. 

 

Figure 6-8. Newly created absorbance measurement window 

6-2. Absorbance of Sample 

After setting the absorbance measurement, set the sample to be measured in the cuvette holder. The 

figure below is an example of absorbance measurement of sample solution. 

 
Figure 6-9. Absorbance of methylene blue solution 
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6-3. Graph Toolbar Icons 

The graph toolbar icons in the absorbance measurement window include icons for adjusting the 

spectrum scale, similar to the graph toolbar in the Spectrum measurement window. 

6-3-1. Measurement Mode Switching Icons 

In addition to the common toolbar icon, there are a set of measurement mode switching icons for 

measuring absorbance, transmittance, and reflectance. 

 
Figure 6-10. Measurement mode switch icons 

By clicking the icons, you can switch among four modes: S (spectrum), A (absorbance), T 

(transmittance) and R (reflectance). The four figures below show the results of switching the sample 

measurement results in Figure 6-9 to four modes: S, A, T, and R.  

  

Figure 6-11. Switch to spectrum mode with S icon         Figure 6-12. Switch to absorbance mode with A icon 

  

Figure 6-13. Switch to transmittance mode with T icon    Figure 6-14. Switch to reflectance mode with R icon 

A (absorbance) represents the light absorbed by the sample, and T (transmittance) represents the light 

passed through the sample, so the two are contradictory. In addition, T (transmittance) and R 

(reflectance) are similar, because R (reflectance) measures the reflected light, which is the light 
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remaining after the light from the light source hits the object to be measured and is absorbed by the 

object.  

The peak positions of T (transmittance) and R (reflectance) coincide, and these peak positions are 

reversed with A (absorbance). 

6-3-2. Setting a New Reference Spectrum or Dark Spectrum 

In some cases, it may be necessary to set a new reference spectrum or a new dark spectrum during 

the measurement, you needn’t to start the measurement from the measurement menu and make a new 

setting, SEC Spectra allows you to easily reset the reference spectrum or dark spectrum using the toolbar 

icons as shown below.  

 

Figure 6-15. Set as reference spectrum icons 

 
Figure 6-16. Set as dark spectrum icons 

To reset the reference spectrum, switch the object to be measured to the reference object and press 

the Set as reference spectrum icon. To reset the dark spectrum, turn off the shutter of the light source 

or block the optical path and press the Set as dark spectrum icon.  

Basically, whenever a measurement needs a reference or dark spectrum to work, the Set as reference 

spectrum icon or Set as dark spectrum icon will appear on the toolbar. This is the same for absorbance, 

transmittance and reflectance measurement.  
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6-4. Saving Absorbance Measurement 

6-4-1. Saving Absorbance Spectrum Curve 

The method of saving the absorbance measurement spectrum is the same as that of "spectrum 

measurement".However, in the spectrum measurement, only one curve of the spectrum is saved, and in 

the absorbance measurement, three curves are saved: reference spectrum, dark spectrum, and 

absorbance spectrum. 

Click the "Save selected spectrum as..." icon on the graph toolbar to save the spectrum curve. 

 

Figure 6-17. Saving absprbance spectrum by Save selected spectrum as... icon 
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Alternatively, select "Save all spectra as ..." from the pop-up menu in the spectrum data window. The 

three saved curves can be viewed in the specified folder as shown below. 

For detailed saving procedure, also refer to "14-8. Saving Currrent Spectrum" in the software operation 

method. 

 

Figure 6-18. Saved absorbance spectrum 

6-4-2. Loading Saved Absorbance Spectrum Curve 

To load a previously saved absorbance spectrum, you can click "Open Spectrum File" from the File 

menu to display the absorbance spectrum in a new or existing window on the software. For details, refer 

to "14-1-1. Open Spectrum File". 

6-4-3. Deleting Absorbance Measurement 

The result of the absorbance measurement is calculated by multiple spectral curves. Therefore, do not 

delete any curve. If you delete any of the curves, the software will not be able to display the absorbance 

correctly. 

6-4-4. Print and Preview of Absorbance Spectrum Curve 

If you want to print the spectrum of the absorbance spectrum, use the "Print Preview"  and 

"Print"  icons on the toolbar. For details, refer to "14-9-3. Print Preview and Print". 
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7. Transmittance Measurement 

The transmittance is calculated from the spectrum of the light has passed through the reference 

object (blank solvent injection into the cuvette holder) and the object be measured (sample solution 

injection into the cuvvete holder). Smilarly to the measurement of absorbance, in order to measure the 

transmittance, first measure the transmitted spectrum of the reference object (baseline measurement),  

then set the object to be measured and measure the light transmitted through the object to be 

measured. When the measurement is completed, the program automatically calculates the 

transmittance spectrum. 

7-1. Creating a Transmittance Measurement 

For the transmittance measurement, select Transmittance from the Measurement menu and open 

the New Transmittance Measurement window, as shown below. 

 

Figure 7-1. Selecting Transmittance from the Measurement menu 

7-2. Setting Measurement Conditions 

Set the measurement conditions in the same procedure as in "6-1. Creating an Absorbance 

Measurement".  

On the Source Device screen, select the source device (displayed by device serial number) and press 

Next.  

First, set the reference material in the cuvette holder. Then, on the Data acquisition parameter screen, 

set the Integration time, Number of scans to average and Boxcar width. When all the parameters are 

set, click Next. 

Set the Reference spectrum and Dark spectrum. 

On the Display Settings screen, set the Window name, Spectrum title, and Graph color. 

When you have finished the display settings, click OK. The measurement window is displayed as 

shown in Figure 7-2. 
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Since the reference object is set, the transmittance is 100% in Fig. 7-2. 

 

Figure 7-2. Newly created transmittance measurement window 

7-3. Transmittance of Sample 

Next, set the object to be measured and measure the transmittance. The result of measuring the 

sample is displayed in the figure 7-3. 

 

Figure 7-3. Transmittance of methylene blue solution 
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7-4. Saving Transmittance Measurement 

The method of saving the transmittance spectrum is the same as that for the absorbance spectrum. 

For details, refer to "14-8. Saving Currrent Spectrum". 

 

To load the previously saved transmittance spectrum, you can display the transmittance spectrum in a 

new or existing window on the software by clicking Open Spectrum File from the File menu. For details, 

refer to "14-1-1. Open Spectrum File". 

If you want to print the spectrum of the transmittance spectrum, use the Print Preview  and Print

 icons on the toolbar. For details, refer to "14-9-3. Print Preview and Print". 
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8. Reflectance Measurement 

Reflectance is calculated from the reflection spectrum from the reference object and the reflection 

spectrum from the object to be measured. Therefore, to measure the reflectance, first irradiate the 

reference object with light sourcce and measure the reflected light. Then, irradiate the object to be 

measured with light sourcce and measure the reflected light. The program will automatically calculate 

the reflectance spectrum when the measurement is complete. 

8-1. Creating a Reflectance Measurement 

For reflectance measurement, select Reflectance from the Measurement menu to open the New 

Reflectance Measurement window, as shown below. 

 

Figure 8-1. Selecting Reflectance from the Measurement menu 

8-2. Setting Measurement Conditions 

Set the measurement conditions in the same procedure as in "6-1. Creating an Absorbance 

Measurement".  

On the Source Device screen, select the source device (displayed by device serial number) and press 

Next.  

First, set the reference material in the cuvette holder. Then, on the Data acquisition parameter screen, 

set the Integration time, Number of scans to average and Boxcar width. When all the parameters are 

set, click Next. 

Set the Reference spectrum and Dark spectrum. 

On the Display Settings screen, set the Window name, Spectrum title, and Graph color. 

When you have finished the display settings, click OK. The measurement window is displayed as 

shown in Figure 8-2. 
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In Figure 8-2, the reference object is set, so the reflectance is 100%. 

 

Figure 8-2. Newly created reflectance measurement window 

8-3. Reflectance of Sample 

Next, set the object to be measured and measure the reflectance. The figure below shows an example 

of the result of measuring the reflectance. 

 

Figure 8-3. Reflectance measurement of a sample 
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8-4. Saving Reflectance Measurement 

The method of saving the reflectance spectrum is the same as that for the absorbance spectrum. For 

details, refer to "14-8. Saving Currrent Spectrum". 

 

To load the previously saved reflectance spectrum, you can display the reflectance spectrum in a new or 

existing window on the software by clicking Open Spectrum File from the File menu. For details, refer to 

"14-1-1. Open Spectrum File". 

If you want to print the spectrum of the reflectance spectrum, use the Print Preview  and Print

 icons on the toolbar. For details, refer to "14-9-3. Print Preview and Print".  
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9. Strip Chart (Recording Specific Wavelength) 

SEC Spectra provides a Strip Chart for continuous observation of numerical changes in a specific 

wavelength or wavelength range. Since it is necessary to create the target spectrum in advance for the 

Strip Chart measurement, the following explanation is from the state where the "Absrbance_0" 

spectrum curve has been created in advance. 

9-1. Creating a Strip Chart Measurement 

From the Measurement menu, select Strip Chart to open a New Strip Chart window: 

 

Figure 9-1. Selecting Strip Chart from the Measurement menu  
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9-1-1. Strip Chart Settings 

The New Strip Chart window is shown in Figure 9-2. 

First select the desired source spectrum from the New Strip Chart-Strip Chart Settings window. Software 

automatically selects the target measurement window that is currently open. You can also click manually. 

Figure 9-2 shows the case where Absrbance_0 is automatically selected. 

Then, select the wavelength or wavelength range and press Add. If you want to add multiple 

wavelengths, repeat the operation selecting the desired wavelengths and press Add.  

Note: The software will automatically select the closest wavelength. 

  

Figure 9-2. New Strip Chart - Strip Chart Settings     
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9-1-2. Record Settings 

When you press Recording Setting button in Figure 9-2, the Recording setting screen (Figure 9-3) is 

displayed, and you can set the data acquisition Interval and When to stop. After completing the settings, 

press OK, and then press OK in the dialogue that appears. 

After completing the settings, click Next in the New Strip Chart-Strip Chart Settings window (Figure 9-2).  

Interval 

If you check on Synchronize with source, it will be the same as the acquisition interval of the original 

spectrum. If you uncheck it and enter the acquisition interval, data will be acquired at the set interval. 

The default setting is 500 ms and can be changed to sec, min, hr as needed. 

When to stop 

Next, set the stop time. If you check on Continue until stoped by user, it will continue until you stop it by 

pressing the Stop icon on the toolbar of the Strip Chart measurement screen that opens in the next step. 

You can uncheck it, enter the recording time, and set the time until it stops.  

 

Figure 9-3. Strip Chart Settings - Record Setting  
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9-1-3. Display Settings 

Now, on the Display Settings window, specify name for the new strip chart window. When all settings 

are done, click OK. SEC Spectra will display the newly created strip chart, as in the following figure: 

 

Figure 9-4. Newly created Strip Chart window 

In figure 9-4, strip chart curves are displayed at 10-minute intervals. The X-axis scale has a default 

interval of 10 minutes. The X-axis width is automatically adjusted up to the default 10 minutes, and 

automatically scrolls to the left if it exceeds 10 minutes. 

 

Figure 9-5. The chart starts scrolling after ten minutes 

Note: When multiple wavelengths are added in the Strip Chart Settings, not all curves may be displayed. 

In this case, press the autoscale icon on the toolbar to show all curves. 

https://www.als-japan.com/


 SEC Spectra User's Guide 9. Strip Chart (Recording Specific Wavelength) 

https://www.als-japan.com  44 

9-2. Toolbar Icons 

In the graph toolbar, in addition to the icons for scale adjustment, saving, printing, etc., which are 

similar to spectrum measurement, there are icons dedicated to the Strip Chart (where marked with a red 

border).  

 

Figure 9-6. The toolbar icons of Strip Chart 

9-2-1. Strip Chart View 

 

Figure 9-7. The Strip Chart View icon 

This icon allows you to stop scrolling the Strip Chart window. Strip Chart emulates a continuous chart 

paper, so the graph will scroll to the left. Pressing this button will temporarily freeze the scrolling. Press 

the button again can unfreeze it. Freezing the strip chart will not stop it from capturing new data. The 

software will keep recording new data in the background, so you will see continuous data when you 

unfreeze the chart. 

When scrolling is active, this icon has a blue frame, and when scrolling is inactive, it lacks the frame. See 

the following figure:  

     
Figure 9-8. The "active"(left) and "inactive"(right) states of the Strip Chart View icon  
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9-2-2. Data Display (X-axis) 

 

Figure 9-9. The control for modifying the time period for data display 

Here, you can specify the X-axis display of the strip chart. The display format can be selected from: 

delta time (the elapsed time from the start of acquisition), delta data (the number of data from the 

acquisition start), and min, hour, day (time, date). 

 

Figure 9-10. X-axis display of Strip Chart 

When setting to delta time, the unit can be selected from: s and min. 

For delta time and delta data, the width can be selected from: 10,20,…, 100. 

The default X-axis display is delta time, with a width of 10 and units of min (minutes). 

     

Figure 9-11. Unit of delta time          Figure 9-12. Display width of delta time 

9-2-3. Reset and Stop Icon 

Press the reset icon  to reset the acquired data of the Strip Chart. The newly imported data will be 

the first data. Press the stop icon  to stop the Strip Chart screen. 
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9-2-4. Record Setting Icon 

When you press the recording setting icon , the recording setting window 

(  

Figure 9-3. Strip Chart Settings - Record Setting) is displayed. You can edit the recording conditions. 

9-2-5. Scroll Bar State Icon 

 
Figure 9-13. Scroll Bar State icon 

If you press the Scroll Bar State button to make it the blue state shown above, the spectrum data will always be 

displayed with the latest data (lower region of the data frame). When Scroll Bar State is white, it is displayed in 

the normal order(upper region of the data frame). 

9-3. Saving Strip Chart 

Click the save icon  on the graph toolbar to save the Strip Chart data. A file will be formed for 

each wavelength measured. You can save the spectrum checked for selection at the same time. Click the 

save icon on the graph toolbar to save the Strip Chart data. A file is formed for each measurement 
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wavelength. You can save the spectrum checked in Select at the same time. You can select the file type 

from spt and csv by clicking the Application Settings icon (refer to "14-3-2. Save").  

 
Figure 9-14. Saving a Strip Chart 

9-4. Loading Strip Chart File 

To load a previously saved Strip Chart result (extension spt), you can view the Strip Chart result in a 

new/existing window on the software by clicking Open Spectrum File from the File menu. For details, 

refer to "14-1-1. Open Spectrum File、14-1-2. Open Strip Chart File" . 

The following is an example of displaying multiple items in a New window-Same window.  

 

Figure 9-15. Displaying the StripChart results in a New window-Same window 
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10. Time Sequence Measurement (Recording Full 

Wanvelength) 

10-1. Time Sequence Window 

SEC Spectra provides a Time Sequence function that records changes in full wavelength range (or the 

save wavelength range set in "14-3-2. Save") over a period of time. From View--Time Sequence 

Measurement on the menu bar, or by moving the mouse cursor over Time Sequence button on the right 

edge of the SEC Spectra window, the Time Sequence window is displayed. 

 

Figure 10-1. The Time Sequence button and the Time Sequence window 

When you move the mouse, the window closes automatically. If you want it to stay on the screen, you 

can click on the push-pin icon on the upper-right corner of the pane to fix it. See the following figure: 

 

Figure 10-2. The push-pin for pinning the Time Sequence window 
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10-2. Settings of Time Sequence Measurement 

10-2-1. Selecting Spectrum 

First, select the spectrum to be recorded. The software will automatically select the currently open 

measurement window. Figure 10-3 shows an example where Absorbance_0 is automatically selected. 

You can also select it manually by checking Select box to the left of the spectrum name. 

Note: Do not change the window while recording as this will be deselected if you open or work with 

another window during recording. Also, if you press the record icon and the message "Spectrum is not 

selected" is displayed, the selection may have been disabled by some operation, so please check on the 

Select frame again manually. 

10-2-2. Specifying the save destination folder 

First, you need to specify the folder to save the recorded data. The default is the desktop. If necessary, 

it is possible to change it using the Save In… icon on the top of this window. 

 
Figure 10-3. Save In icon in the Time Sequence window 

10-2-3. When to Start 

Next, specify the start time. The default setting is Start after the first data. You can set the delay time 

for synchronization with the quiet time of the electrochemical measurement. The default setting is 1 ms 

(millisecond). In effect, recording starts as soon as you chick the Record button. Never set to zero (0) 

here, or there will be an error. 

If you want to start recording immediately by pressing Record icon, please check on Start. 

 

Figure 10-4. Setting When to start  
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10-2-4. Interval 

You can set an acquisition interval for the recording. The default interval is Synchronize with source to 

keep an equal acquisition interval of the original spectrum. If unchecked, it will be acquired at the input 

interval (default setting: 500 ms). If necessary, it can be changed to sec, min, hr.  

 

Figure 10-5. Setting Interval 

10-2-5. When to Stop 

Next, specify the stop time. The default is Continue until stopped by user, until you press the Stop 

icon at the top of the pane to stop recording. If it is unchecked, it automatically stops at the set time.  

 

Figure 10-6. Setting When to Stop 

10-2-6. What to Save 

By default, Create file every data acquisition interval is checked. Each data acquisition interval is 

saved in a file format according to each measurement mode (file type: sps), and can be opened from 

File-> Open Spectrum File. 

Next, specify the spectrum to be saved. The default is all the measured spectrum curves. If Create file 

at every tracking interval is unchecked, it will be saved as a file format dedicated to time sequence 

measurement (file type: spc), and can be played from File -> Open Time Sequence File. For details, refer 

to "10-4. Loading and Playing Time Sequence File". 

 

Figure 10-7. Setting What to save  
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10-2-7. Selecting File Format 

As mentioned above, the save file format is sps or spc depending on whether Create file at every 

tracking interval is checked, but it is also possible to use scv format. 

It can be selected in the dropdown Manu next to the Save to ... icon at the top of the window. 

 

Figure 10-8. Select the save file format 

10-3. Recording Time Sequence Measurement 

After setting the above options, press the Record button at the top of the window to start recording. 

 

Figure 10-9. Record icon 

Note: If you make multiple measurements and record, you will see the message "Please make only one 

measurement for each spectrometer. You may lose some of your data.", please click on Continue. 

During and after recording, a green band may appear on the software screen, indicating that the 

spectrometer is communicating with the computer. Regardless of this indication, data will be recorded 

and saved according to the setting conditions. 

 

Figure 10-10. Green band display  
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10-4. Loading and Playing Time Sequence File 

The file (extension sps) saved in Create file at every tracking interval can be opened by selecting 

Open spectrum file from the File menu. For details, refer to “14-1-1. Open Spectrum File”. 

The data saved without checking Create file at every tracking interval (extension spc) can be read from 

Open Time Sequence File in the File menu. 

 

Figure 10-11. Selecting Open Time Sequence File from the File menu 

This opens the system standard Open window. Now locate the file you saved earlier, and then click the 

Open button. 

 

Figure 10-12. Selecting previously saved file in the Open window  
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Once the file is opened, SEC Spectra will display the playback tools for the time sequence file. 

 
Figure 10-13. The playback tools for the time sequence file 

As shown in the above figure, there are icons that allow the user to Fast-rewind, Play, Pause, and 

Fast-forward the playback of time sequence (see the red highlighted area near the bottom). These icons 

work just like the way they do in video playback. Through playback, you can easily go back and forth to 

find out how the measurement reading changes. Moreover, you will notice that the time sequence file 

will keep playing over and over again once it is loaded until you press the Pause button. 
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11. Relative Irradiance Measurement 

Relative Irradiance measurement is a measurement method for confirming the spectral waveform of a 

luminescent sample such as fluorescence or electrochemical emission to a reference light source with a 

known color temperature. 

11-1. Creating a Relative Irradiance Measurement 

To start a new relative irradiance measurement, press "I" icon at the top of the toolbar to open the 

setting screen.  

 
Figure 11-1. Relative Irradiance from the I icon 

Next, please select source device on the Source Device window. Then, click Next. 

11-1-1. Color Temperature 

Set the color temperature of the reference light source. Example: It is 5500K when both the D2 and 

HAL lamp of the SEC2020 spectrometer system are used. It is 2800K when only the halogen lamp is used. 

 

Figure 11-2. Setting color temperature  
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11-1-2. Setting Measrement Conditions 

Next, set the Integration time, Average, and Boxcar in Data acquisition parameters. When you have 

finished setting all the parameters, click Next. 

Set the reference spectrum when the reference light source is on and the dark spectrum when it is 

blocked. 

Specify the graph window name, spectrum name, and graph curve color in Display Settings. Press OK. 

When the setting is completed, SEC Spectra will display the relative irradiance measurement graph. 

The figure below is an example of the relative irradiance spectrum when only the halogen lamp of the 

SEC2022 light source is turned on.  

 
Figure 11-3. Newly created Relative Irradiance measurement window 
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11-2. Relative Irradiance Sample Measurement 

Install a sample and measure the Relative Irradiance. 

 
Figure 11-4. The Relative Irradiance measurement graph for a LED lamp 

11-3. Saving Related Irradiance Measurement 

The method of saving the current Relative Irradiance spectrum is the same as that for the absorbance 

spectrum. For details, refer to "14-8. Saving Currrent Spectrum". 

To load a previously saved Relative Irradiance spectrum, you can display in a new or existing window on 

the software by clicking Open Spectrum File from the File menu. For details, refer to "14-1-1. Open 

Spectrum File ". 

 If you want to print the spectrum of the Relative irradiance spectrum, use the Print Preview  and 

Print  icons on the toolbar. For details, refer to "14-9-3. Print Preview and Print".  
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12. Concentration Measurement 

Spectrum-based concentration measurement captures the spectrum of a light source after it passes 

through the test solution, and then compares the spectrum with the light source's original spectrum to 

come up with the concentration of the solution by applying a known calibration table or the Beer's Law. 

Accordingly, as in the absorbance measurement, the spectrum of reference solution is measured first, 

then the spectrum of the test solutio. SEC Spectra provides a straightforward procedure to measure 

concentration. All you have to do is follow the step-by-step windows to create a concentration 

measurement. 

12-1. Creating a Concentration Measurement 

To create a concentration measurement, please select Concentration from the Measurement menu to 

open the New Concentration Measurement window, as shown in the following: 

 

Figure 12-1. Selecting Concentration from the Measurement menu 

12-1-1. Setting Measurement Conditions 

Set the measurement conditions in the same procedure as in "6-1. Creating an Absorbance 

Measurement".  

On the Source Device screen, select the source device (displayed by device serial number) and press 

Next.  

First, set the reference material in the cuvette holder. Then, on the Data acquisition parameter screen, 

set the Integration time, Number of scans to average and Boxcar width. When all the parameters are 

set, click Next. 

Set the Reference spectrum and Dark spectrum. 

On the Display Settings screen, set the Window name, Spectrum title, and Graph color. 

  

https://www.als-japan.com/


 SEC Spectra User's Guide 12. Concentration Measurement 

https://www.als-japan.com  58 

12-2. ConcentrationSettings 

After completing the display settings, press OK to open the Concentration Settings screen. Set the 

information to calculate the concentration from the measured spectrum. There are two calculation 

methods: one is to create a calibration curve from samples with known concentration (Figure 12-2), and 

another is to specify the parameters of Lambert-Beer's law (Figure 12-3). 

 
Figure 12-2. Concentration Settings - Calibration Table From Known Concentration 

 
Figure 12-3. Concentration Settings - Beer's Law Settings  
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12-2-1. Creating a Calibration Curve from Known Concentration 

The following is an example of how to create a calibration curve from a sample with a known 

concentration. 

① Place the solution of known concentration (No. 1) in the cuvette holder, and enter Specific 

wavelength (420 nm in this case) in the Wavelength field of the Create calibration data from known 

concentration screen, and the software will automatically select the closest wavelength.  

② Next, enter the value corresponding to Concentration in the Calibration data field and press Get 

icon to measure the absorbance. 

③ Click Add to list icon. Add this absorbance to the table list on the right.  

④ Then, place a solution of known concentration (No.2) in the cuvette holder. Then enter the 

Concentration value and press Get icon to measure the absorbance of this concentration. 

⑤ Repeat the same operation using solution of known concentration. If you get 2 points, the 

parameters of the regression curve will be displayed. 

⑥ If you want to delete the data, select the data row in list and click Delete icon to delete the point. 

⑦ Compound name and Concentration unit entered here will be displayed in the concentration 

measurement graph (Figure 12-5). 

 

Figure 12-4. Configuration of Concentration Settings - Calibration Table From Known Concentration   
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When you have finished setting the concentration curve, you can save the concentration calibration 

data using Save Table button at the bottom of the screen. The saved data can be loaded using the Load 

Table button. When you have finished the settings, click Apply. Once the settings have been applied, the 

concentration curve will be displayed in a measurement window similar to the Strip Chart, as shown 

below. 

 

Figure 12-5. Newly created concentration measurement graph  

https://www.als-japan.com/


 SEC Spectra User's Guide 12. Concentration Measurement 

https://www.als-japan.com  61 

12-2-2. Beer’s Law Settings 
If you want to measure the concentration from Lambert-Beer's law, click on the Beer's Law Settings tab, set the 

parameters in the following screen and click Apply to create the measurement diagram (Figure 12-5). 

Molar absorptivity (ε): Enter the absorption coefficient of the compound. Enter the coefficient according to the 

concentration unit you want to display. 

If the concentration unit is molar (M), enter the coefficient unit in "M-1⋅cm-1"; 

if the concentration unit is mmol (mM), enter the coefficient unit in "mM-1⋅cm-1". 

Path length: Enter the optical path length (cm) of the cell used for measurement. 

Wavelength: Enter the absorption peak wavelength (nm) to be measured. 

Once the Compound name and Concentration unit have been entered, they will be displayed as Compound 

Name and unit in the concentration measurement graph. 

 

Figure 12-6. Beer’s Law Settings  
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12-3. Start Measuring the Concentration of Test Solution 

The solution to be measured is then placed in the cuvette holder and the concentration is measured. 

Use the Auto scale icon to adjust the display. 

 

Figure 12-7. The concentration graph of the test solution 

12-4. Concentration Setting Icon 

Except for the same toolbar icons as in Strip Char, there is a button dedicated to Concentration 

Setting for concentration measurement. See the following figure:  

 

Figure 12-8. Concentration Setting icon 

Concentration Setting icon opens the window for you to specify the Calibration Table From Known 

Concentration and Beer's Law Settings.  
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12-5. Saving the Concentration Measurement 

The procedure for saving the concentration measurement results is the same as for Strip Chart, using 

the Save icon  on the toolbar. Please refer to "9-3. Saving Strip Chart" of Strip Chart measurement. 

 
Figure 12-9. Saving the concentration measurement 

To load the previously saved concentration measurement result, open it from Open Spectrum File ... 

in the File menu. For details, refer to "14-1-2. Open Strip Chart File". 

 

The result of one concentration measurement is calculated by multiple spectral curves. Therefore, do 

not delete any curve. If you delete any of the curves, the result will not be calculated correctly. 
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13. Trigger Mode Settings 

The SEC2020 spectrometer system supports "trigger mode". The external TTL signal applied to the 

spectrometer’s I/O port controls data acquisition of the spectrometer.  

Please refer to chapter "Synchronization with other devices" of "SEC2020 Spectrometer System User's 

Guide -Devices-". 

13-1. Enable Trigger Mode 

To use the trigger function, the instrument must be set to trigger mode. Prepare a spectrum such as 

Spectrum or Absorbance measurements in advance. 

Select Trigger Settings from the Settings menu.  

 

Figure 13-1. Select Trigger Settings from the Settings menu 

The Trigger Settings window shows:  

 
Figure 13-2. Setting Trigger Mode  

① 

② 

③ ④ 
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Follow the steps below to set up trigger mode. 

① Check the selection (serial number). 

② Select the trigger mode: 

SW Level Trigger: Starts/Stops software measurement by TTL signal. 

SW Continuous Trigger: Starts software measurement with TTL signal. To stop it, manually stop the 

software. 

③ Click Enable icon to activate the trigger mode setting. 

④ Click OK icon to exit the screen. 

 

The spectrum acquisition mode is now the trigger mode. 

At this time, the signal on the spectrum screen stops and the data acquisition is stopped. The external 

TTL signal applied to the I/O port of the spectrometer is at “Low level” and the spectrometer is in 

standby mode. 

Note: If data acquisition does not stop after switching to trigger mode, concfirm the TTL signal applied to 

the I/O port or the software settings, as data acquisition starts when the TTL signal goes to “High level”. 

 

You can check the current mode status from Spectrum List--Mode: **. The figure below shows the 

state set for SW Continuous Trigger mode. 

 
Figure 13-3. Spectrum List-- Mode: SW Continuous Trigger  
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13-2. Trigger Off (Normal Mode) 

To return from trigger mode to normal mode (trigger off), select Trigger Settings from Settings menu 

and set according to the following procedure. 

① Check the selection (serial number). 

② Select the trigger mode: 

Trigger Off: Releases from the trigger state. 

③ Click Enable icon to activate the changing of the mode. 

④ Click OK icon to exit the screen. 

At this time, the signal on the spectrum screen moves and data is acquired. 

 

You can check the current mode status from Spectrum List--Mode: **. The figure below shows the 

state set for Trigger Off (normal) mode. 

 
Figure 13-4. Spectrum List-- Mode: Trigger Off 
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14. Software Operation Methods 

This chapter describes the basic operation methods such as software menus and icons. 

14-1. File Menu 

14-1-1. Open Spectrum File 

You can read the saved spectrum curve (extension sps) and analyze the data on the software or 

compare it with the current spectrum. 

The procedure is as follows. 

From the File menu, click Open Spectrum File ... 

The Open Existing File screen is displayed. Use the Browse icon to select a previously saved file. Then click 

Next to display the Display Settings screen. 

                        

                            Figure 14-2. Open Existing File 

On the Display Settings screen, select Select existing window to display the spectrum in the current 

Spectrum_0 window. Display in new window creates a window separate from Spectrum_0. Press OK.   

Figure 14-1. Select Open Spectrum File 

from the File menu  
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Figure 14-3. Open Existing File-- Display Settings 

The figure below shows the result of opening Spectrum_1 when the wavelength interval is set to 10 nm 

and Spectrum_0 when the default setting is set at the same time. The spectra are overlay in this way, 

making it easy to compare spectral differences. 

 
Figure 14-4. Select existing window to display the spectrum  
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To open multiple spectrum files at the same time, select multiple files from Open Spectrum File. 

 

Figure 14-5. Open multiple spectrum files 

On the Display Settings screen, check Same Window under Display in new window. If you do not 

check Same Window, a window will be created for each file. 

 
Figure 14-6. Display in new window -- Same Window  
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Figure 14-7. Display spectrum in new window -- Same Window 

14-1-2. Open Strip Chart File 

You can load the saved Strip Chart file (extension spt) and analyze the data on the software or compare 

it with the current spectrum. 

Click File -> Open Spectrum File in the same way that you open a spectrum file. On the Display Settings 

screen, select Show in New Window or Select Existing Window to display the spectrum. 

 

Figure14-8. Display the saved Strip Chart in New Window--Same Window  
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14-1-3. Open Time Sequence File 

Load the previously saved time series measurement file (video) and analyze it on the software. For 

details, refer to "10-4. Loading and Playing Time Sequence File". 

14-1-4. Close All Measurements 

SEC Spectra can "close all measurements". It is very useful when closing a large number of windows. 

Select Close All Measurements from the File menu.  

 

Figure 14-9. File -- Close All Measurements 

14-1-5. Page Setup and Print 
Press Print Preview from the File menu to open the Print preview window and display the current 

spectrum diagram. 

 

Figure 14-10. Print Preview window  

https://www.als-japan.com/


 SEC Spectra User's Guide 14. Software Operation Methods 

https://www.als-japan.com  72 

You can zoom in to check the details and make sure this is the way you like it. Click the printer icon on the 

upper-left corner of the Print Preview window to start printing. If you don't need to preview the graph 

before you print it, you can simply press the Print button on SEC Spectra's graph toolbar to open the 

standard Print window: 

 

Figure 14-11. Print window 

In addition, the File menu also provides a Page Setup option. This feature lets you select the desired 

paper, orientation, and margins. 

 

 

Figure 14-12. Page Setup window  
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14-1-6. Language 

The language used in the program interface can be changed. In the File menu, select Language. When 

you finish selecting, the program screen will switch to the supported language. Figure 14-13 is an example 

of switching from English to Japanese. 

 

Figure 14-13. Selecting Language from the File menu 

14-1-7. Device Information 

If you need to view detailed information about a connected device, go to the File menu, and then select 

Device Information, as shown in the following figure: 

 

Figure 14-14. Selecting Device Information from the File menu 
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Then, the following window appears, showing details about the device: 

 

Figure 14-15. Device information details  

https://www.als-japan.com/


 SEC Spectra User's Guide 14. Software Operation Methods 

https://www.als-japan.com  75 

14-2. View Menu 

Each window can be displayed by checking the Device List, Spectrum List, Time Sequence and Light 

Source control in the View menu. 

 
Figure 14-16. View menu 

14-2-1. Device List 

Click Device List on the left side of the SEC Spectra program window as shown below to expand the 

window and display the connected devices. 

 

Figure 14-17. Device List 

Device List shows the basic attributes of connected devices, such as models, serial numbers (SN), and 

wavelength ranges. 

Note: The serial number is how SEC Spectra identifies each device. This number is also used in several 

windows where device selection is required. 
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14-2-2. Spectrum List 

Click Spectrum List on the left side of the SEC Spectra program window displays the measured 

spectrum, absorbance, transmittance, etc., or the opened spectrum.  

 

Figure 14-18. Spectrum List 

14-2-3. Lamp Control 

SEC Spectra can control the on/off states of SEC2021 light source by setting it to Auto mode via the I/O 

port of the spectrometer and the light source. For details on I/O port and connections, refer to the 

chapter "Device User's Guide, 3-2-2 Automatic Mode". When you move the mouse cursor from 

View->Light Source menu or on the vertical Light Source icon on the right edge of the SEC Spectra window, 

the light source frame is displayed. 

 

Figure 14-19. Light Source icon  
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The operation mode of the Lamp Control icon has two modes of "Automatic" and "Manual". Press it once 

to Automatic mode, press it again to Manual mode. In the initial state of the software, the icon is in 

Automatic mode as shown in Fig. 14-20 (left), only the halogen lamp is checked. If you need to control 

on/off of the light source on the software, turn on the "Auto" swich of SEC2022 light source(Auto LED 

lights up) first. Then, as shown in Fig. 14-20 (right), the on/off of the shutter, halogen light source, and 

deuterium (D2) light source can be controlled on the software while the Lamp Control is in Automatic 

mode. 

  

Figure 14-20. Lamp Control icon in Manual mode (left) and Automatic mode(right) 

14-2-4. Font 

You can also adjust the size of the font for the user interface. Go to the View menu, and then select 

Font. You can choose the font size that best fits your needs. 

 

Figure 14-21. Selecting Font from the View menu  
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14-3. Application Settings 

In SEC Spectra, you can customize default values such as wavelength display range, background color of 

a measurement graph, the default smoothing settings, etc. 

To change these settings, select Application Settings from the Settings menu. 

 

Figure 14-22. Selecting Application Settings from the Settings menu 

Next, the Application Settings window opens. 

14-3-1. Default Settings 
Default Settings allows you to change the default setting for each measurement (spectrum, absorbance, 

transmittance, reflectance and relative irradiance). The settings must be made for each measurement. 

  

Figure 14-23. Default Settings tab of Application Settings 

Measurement 

Set the default display of the measurement selected from the pull-down on the right side. 
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Display Range: Start and End 

Display range start and Display range end of the X-axis and Y-axis can be configured. The Y-axis unit is 

different for each measurement and must be set individually. 

Average 

Here you can specify the default average number of scans. This reduces the effects of noise. 

Boxcar 

This setting allows you specifying the default for the Boxcar smoothing. It varies from 0 to 10, the larger 

the number, the smoother the curve. The default value is 0, i.e. no smoothing. 

Display a Message when the Peak Value in the Spectrum Exceeds 65535 

The maximum value supported in the spectrum data is 65535. Therefore, when the "peak value" of the 

spectrum exceeds this value, the spectrum curve will not be accurate, and a warning message is displayed 

on the spectrum diagram. 

 

Figure 14-24. Data distorted warning message 

In some cases, you may see this warning message even if the spectral curve looks normal. This is because 

the curve displayed on the graph is the result after smoothing, so even if it looks normal, the original data 

is out of tolerance. Therefore, it is necessary to adjust the total time to be short until the warning message 

disappears. 
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14-3-2. Save 

In Save tab, you can set how to save the measurement data (wavelength range, wavelength interval, file 

format).  

 
Figure 14-25. Save tab of Application Settings 

Wavelength Range 

The start and end points can be changed by checking Enabled. If Enabled is unchecked, the 

spectrometer-specific wavelength range of 200 to 1025 nm is set. 

Wavelength Interval 

Check Enable and set the wavelength interval from the pull-down menu. If Enable is unchecked, it will 

be set at the pixel compatible interval of the spectrometer. 

File 

You can select one or more file formats to save the spectrum, absorbance, transmittance, reflectance, 

and relative irradiance measurement spectrum from sps, csv, and txt. 

You can select one or both file formats to save records in Strip Chart measurement from spt and csv.  
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14-3-3. Graph 
This tab allowas you to set the line width, window background, graph background, and whether to 

show the visible spectrum. 

 
Figure 14-26. Graph tab of Application Settings 

Line Width 

This controls the line width of the curve on a graph. 

Window Background and Chart Background 

These two control the background styles and colors of the measurement window and the measurement 

graph, respectively. The available styles are None, Brush, and Solid.  
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Human Visible Spectrum 

This allows you to show the visible spectrum on the graph along with the measurement curve.  

 

Figure 14-27. Demonstrating Human Visble Spectrum effects in the Application Settings 

 

Note: For these graph settings, you can click "Apply" to see the effect of a change immediately. 
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14-3-4. Smoothing 
The original spectral curve is not smooth due to the presence of noise. The SEC Spectra provides a 

smoothing function to make the curve smoother. You can also open the Smoothing Settings screen by 

pressing the Smoothing icon  on the toolbar.  

  

Figure 14-28. Smoothing Settings  

On the Smoothing Settings screen, you can select multiple methods from 6 types: "DWT Noise Filter", 

"Savitzky-Golay Filter", "FFT Filter", "Moving Average", "Kalman Filter", and "High Pass Filter". 

DWT Denoise Filter 

Here you specify whether to use the Discrete wavelet transform denoise filter (DWT Denoise Filter). To 

use it, simply select the Enable Filter check box. 

Savitzky-Golay Filter 

Here you specify whether to use the Savitzky-Golay filter. To use it, select the Enable filter check box, and 

then specify the smoothing Degree and the smoothing Mode. The available modes are Reference Curve, 

Reference & Measurement Curve, and Measurement Curve.  
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FFT Filter 

Here you specify whether to use the Fast Fourier Transform (FFT) filter. To use it, select the Enable filter 

check box, and then specify a Threshold value. 

Running Average 

Here you specify whether to use the running average algorithm. To use it, select Enable running average, 

and then specify the number of points to include in the average. 

Kalman Filter 

Here you specify whether to use the Kalman filter. To use it, simply select the Enable filter check box. 

Long Pass Filter 

Here you specify whether to use the long pass filter. To use it, simply select the Enable filter check box. 

Note: Click "Apply" to see the effect immediately after you change these smoothing settings. 
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14-4. Default Layout 

Once you have more than one measurement windows and you have moved the windows around, you 

can go to the Window menu and select Default Layout to revert to their default layout: 

 

Figure 14-29. Selecting Default Layout from the Window menu 

The window layout now reverts back to the way it originally was: 

 

Figure 14-30. The default window layout of the program  
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14-5. Quick Adjustment Field 

There are some setting icons related to spectrum acquisition in the "quick adjustment field" at the 

bottom of the main menu marked with the red border in the figure below. Adjust the data acquisition 

settings (Integration time, Average, Boxcar) here. There are three icons on the right side of Boxcar:   "E" 

(dark current correction), "L" (linearity correction), and "I" (relative irradiance). Further to the left are the 

"Start" and "Pause" icons for data acquisition (see "14-9-9. Start Acquiring and Pause " for details).  

 

Figure 14-31. Quick adjustment field 

Integration time 

Adjust the exposure time of the sensor. The larger the value, the larger the Intensity (Y-axis value) 

displayed in the Spectrum graph.  

Average 

Set the number of scans to calculate the average value. The larger the value, the smaller the fluctuation of 

the curve. 

Boxcar 

Smooths the spectrum curve. Sets the number of data used for moving average calculation. The higher 

the value, the smoother the curve and the less prominent changes. 

Electronic Dark Correction 

When dark current correction is enabled, the dark current is automatically subtracted from the reading. It 

is a 0-point correction when the spectrometer is not receiving light. For details, refer to "15-1. Electronic 

Dark Correction". 

Linearity Correction 

The sensitivity of the spectrometer CCD is not linear with respect to intensity. When the linearity 

correction function is enabled, the correction is performed according to the linearity correction table. For 

details, refer to "15-2. Linearity Correction". 

Relative Irradiance 

Start relative irradiance measurement. For details, refer to "11. Relative Irradiance Measurement".  
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14-6. Graph Toolbar Icons 

Every measurement graph has a row of toolbar icons at the top of the spectrum windows. These buttons 

are divided into two major groups: Scale Adjustment Buttons and Other Easy Access Buttons. 

 

Figure 14-32. Graph tollbar icons 

14-6-1. Scale Adjustment Icons 

SEC Spectra automatically adjusts to the optimum scale for each measurement to display the spectrum 

properly. It provides a set of toolbar icons for you to customize the scales and display ranges. See the 

following red highlighted area: 

 
Figure 14-33. Scale adjustment icons of the spectrum graph 

These buttons are explained in details in the following. 

14-6-2. Scale Graph Axes Automatically 

 

Figure 14-34. Scale graph axes automatically icon 

This icon automatically adjusts the X- and Y- axes to their optimal settings. The following figure shows the 

effect of this icon. In the figure, the X-axis is adjusted to display the entire wavelength range supported by 

the device, while the Y-axis is adjusted so that the curve fills the entire graph as much as possible: 
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Figure 14-35. The effect of using Scale graph axes automatically 

14-6-3. Scale Y-axis Automatically 

 

Figure 14-36. Scale Y-axis automatically iocn 

This icon automatically adjusts the scale of Y-axis to show more details. The following figure shows the 

effect of this button. In the figure, the highest point on the curve is extended to the top of Y-axis: 

 
Figure 14-37. The effect of using Scale Y-axis automatically  
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14-6-4. Scale X-axis Automatically 

 

Figure 14-38. Scale X-axis automatically icon 

This icon automatically adjusts the scale of X-axis to show more details. Using this button will adjust the 

X-axis to display the internal wavelength range of the device, as in the following figure: 

 

Figure 14-39. The effect of using Scale X-axis automatically 

14-6-5. Zoom In 

 

Figure 14-40. Zoom in icon 

This icon enlarges the graph (pulling it closer to you). Here we press Scale graph axes automatically to 

restore the graph to its optimal display settings, and then press Zoom In to demonstrate its effect. The 

following figure shows the result of pressing Zoom In three times:  
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Figure 14-41. The effect of pressing Zoom In 

14-6-6. Zoom Out 

 

Figure 14-42. Zoom Out icon 

This icon shrinks the graph (pushing it away from you). Here we first zoom in on the graph three times, 

and then press Zoom Out twice to demonstrate its effect. See the following figure: 

 

Figure 14-43. The effect of pressing Zoom Out  
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14-6-7. Revert Graph Settings to Application Defaults 

 

Figure 14-44. Revert graph settings to application defaults icon 

This icon restores the graph display settings to application defaults (i.e. the original settings when the 

graph is created). To demonstrate, we press this button to restore the graph in the former example to its 

default settings. See the following figure: 

 

Figure 14-45. The effect of Reverting graph settings to application defaults 
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14-6-8. Graph Settings 

 
Figure 14-46. Graph Settings icon 

This button opens the setting details of X- and Y-axes, as shown in the following: 

 

Figure 14-47. Graph Settings window 

The Graph Settings window allows the user to customize the minimum and maximum values for X- and 

Y-axes, as well as the size of a major step. Here we configure the X-axis (wavelength) range to fall within 

200 to 1025 (nm), with a major step of 100. Then, we configure the Y-axis (signal intensity) range as 0 to 

50000, with a major step of 5000. See the following figure for the result: 

 

Figure 14-48. Using custom X-, Y-axes settings  
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14-6-9. Checking Spectrum Values 

The spectrum curve gives you a quick glimpse of the characteristics of the light being measured. In 

addition, you can check the actual value of a specific wavelength by placing the mouse cursor over a point 

on the curve. As shown in the figure below, when you move the mouse cursor to the bright line derived 

from D2, the actual wavelength (655.82) is displayed at the top of the graph and the data value (52863.78) 

is displayed on the right side of the graph. 

 

Figure 14-49. Checking the value of a specific wavelength with mouse 

The mouse cursor offers a handy way to observing a single point.  To display all measurement data, 

SEC Spectra provides a tabular "Spectral data pane". Details will be explained in chapter 14.7. 
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14-6-10. Placing Marks on the Graph 

Press Placing Marks on the Graph icon on the toolbar and double-click the left button of mouse at the 

position where you want to mark, and the data values on the graph will be fixed and displayed. 

 

Figure 14-50. Place marks on the graph icon 

 

Figure 14-51. he effect of placing marks on the graph 

Note: When you place a mark with the mouse, the program automatically finds the peak value on the 

curve near the location you click and places the mark there. As such, it is better to click on the curve at the 

wavelength position where you want to observe, rather than clicking on the empty space on the graph. 

Otherwise, the mark may go to where the peak value appears, instead of the X position you click. 
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14-7. Spectrum Data Pane 

Press Show spectrum data icon on the toolbar can shows / hides the spectrum data pane. 

 

Figure 14-52. Show spectrum data icon 

  The upper half of the spectrum data pane consists of a list of the underlying spectrum curves of this 

measurement ("Spectrum_0" is the only spectrum curve for this case). There are Spectrum Data, Marks 

and Information tabs at the lower half of the pane. 

The Spectral Data tab shows a scrollable table and uses the scroll bar on the right to navigate to the 

wavelength range you want to check. 

 

 

Figure 14-53. Spectrum Data Pane  
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14-7-1. Marks tab 

In addition to using the mouse, you can also use the spectrum data pane to put marks on the graph, 

with the benefit of better accuracy in selecting the exact wavelengths you want. 

 
Figure 14-54. Add mark in Mark tab 

Adding Marks 

In the Marks tab, we can see the mark we created earlier is already in the list. Please enter or select a 

wavelength (nm) in the Wavelength field, and then select the mark type you want in the Type field. The 

available mark types include Normal, Peak_Intensity, Peak_Lamda, and Peak_FWHM. 

The available four mark types are explained in the following: 

Normal: Shows the intensity of the marked position 

Peak_Intensity: Shows the intensity of the nearest peak 

Peak_Lamda: Shows the wavelength of the nearest peak 

Peak_FWHM: Shows the full width at half maximum of the nearest peak 

After specifying Wavelength and Type, click on the green "+"symbol (i.e. the Add button). A new mark will 

appear at the specified wavelength position.  

Note: The makeable positions of SEC Spectra are located at specific intervals. As a result, the program 

automatically places the mark at the position closest to the specified wavelength position. 
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Deleting Marks 

If you want to delete a mark, you can select the mark you want to delete on Marks tab (multiple choices 

can be selected at a time), and then click on the red "X" symbol (i.e. Delete button) to delete it.  

 

Figure 14-55. Click Delete button after selection 

Temporarily erase the mark 

If you want to turn off the marks temporarily, you can press the Place marks on the graph button. The 

marks will be erased temporarily. You can simply press Place marks on the graph button again to see 

them. 

14-7-2. Information tab 

On the Statistics Information tab, you can see the characteristics of the measurement spectrum (for 

example: average, minimum, maximum and center of gravity). If you want to observe accurate data for a 

specific wavelength range, enter the wavelength range you want to calculate on the Statistics tab and read 

the required information. In the figure below, the table reads the current average, minimum, maximum 

and center of gravity. 

 
Figure 14-56. Statistics Information tab  
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14-8. Saving Currrent Spectrum 

14-8-1. Saving Individual Spectrum Curves from the Toolbar 
If you want to save the current spectrum measurement to a file, you can use the Save selected 

spectrum as… icon on the toolbar. See the following figure: 

 

Figure 14-57. Save selected spectrum as… icon 

Pressing this button shows the Select Spectrum window for you to choose the spectrum curve that you 

want to save. 

Note: The pause icon will automatically activate when the save data icon is pressed. Press the start icon to 

start measuring again. 

 
Figure 14-58. Select Spectrum window 

If there are multiple spectral curves in the same window, save the spectrum individually. Please select 

the spectrum you want to save and click OK. The Save As window appears, specify the destination folder 

and the filename, press Save. The spectrum file will be saved. The default file format is SEC Spectra's 

proprietary file format (extension .sps). You can also save it in CSV or TXT format for use with other 

software. To save in CSV or TXT format, select csv files (extension .csv) or text files (extension .txt) in Save 

as type in the Save As window.  

Note: CSV or TXT format can only be used for other software. SEC Spectra can not read spectrum curves in 

CSV or TXT format.   
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14-8-2. Saving Individual Spectrum Curves from the Spectrum Data Pane 
In addition to saving spectrum curves from the Save selected spectrum as toolbar icon, you can also 

save individual spectrum curves from the spectrum data pane. The upper half of the pane consists of a list 

of the underlying spectrum curves of this measurement. Click on the spectrum curve that you want to 

save, and then right-click in the list to open the pop-up menu. Next, select Save selected spectrum as.  

 

Figure 14-59. Selecting Save selected spectrum as on the pop-up menu 

Next, the Save As window will appear. As in the previous section, please specify the destination folder and 

the filename, and then press Save to save the spectrum as a file. 

14-8-3. Saving All Spectrum Curves in the Current Window 

SEC Spectra allows you to display multiple spectrum curves in one window. Accordingly, if you have two 

or more spectrum curves in a window, you might want to save them all at once, instead of saving them 

individually. First, press the Show spectrum data button on the toolbar (if you have closed the spectrum 

data pane). Right-click in the Spectrum list of the upper half of the spectrum data pane to open the 

pop-up window, and then select Save all spectrums in.  

 

Figure 14-60. Selecting Save all spectrums in on the pop-up menu 

Next, the Browse for Folder window will appear, select the destination folder, and then press OK when 

you have made your selection. All spectrum data files are saved in the specified folder. The file name is the 

title of the spectrum and the file extension is .sps. In this example, the saved file is "Spectrum_0.sps".  
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14-8-4. Saving the Current Spctrum Curves as a Temporary Log 

Besides saving the spectrum as a file, SEC Spectra allows you to save the spectrum curve as a temporary 

log. Temporary logs are displayed on the graph being measured. 

Right-click the mouse in the Spectrum list in the spectrum data pane to bring up the pop-up menu, and 

then select Save as temporary log.  

 

Figure 14-61. select Save as temporary log... from the pop-up menu 

Next, you will see a Please enter the temporary log spectrum name message box, as in the following: 

 

Figure 14-62. Please enter the temporary log spectrum name message box 

You can specify a name for the temporary log spectrum or simply use the default number as the name. 

For example, change the number to "intg30" on condition that the integration time is 30 ms.  

 

Figure 14-63. Renaming the temporary log spectrum  
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Press OK. A new spectrum curve of "intg30" is created in the spectrum graph. If you change the 

integration time of the original Spectrum_0 curve, you can see the difference between the integration 

time of the two curves. 

 

Figure 14-64. Creating a temporary recording spectrum curve 

The two curves are displayed as thicker curves when selected in the spectrum list. The figure above shows 

intg30 selected. 

If you no longer need todisplay the spectrum temporarily, you can delete it from the Spectrum Data list. 

For detailed operations, refer to the following section 14.8.5. 

14-8-5. Deleting Individual Spectrum Curves 

If there are many spectral curves in the spectral graph, you can remove the spectral curves you don't 

need. First, in the Spectrum list of the Spectrum Data pane, select the spectrum you want to delete, 

right-click to open the pop-up menu and select Delete. This will delete the selected spectrum curve. 

 

Figure 14-65. Selecting Delete on the pop-up menu  
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14-9. Other Tool Bar Icons 

14-9-1. Smoothing 

A raw spectrum curve tends to be jagged and spiky, due to the inevitable noises in the original signal. 

SEC Spectra provides a feature to eliminate such noises and smooth out the curve. This is an icon called 

Smoothing on the graph toolbar. See the following figure: Refer to "14-3-4. Smoothing" for detailed 

settings. 

 

Figure 14-66. Smoothing icon 

14-9-2. Showing Peak Values 

Sometimes you need to know the peak values on the curve when you are viewing a measurement 

graph. SEC Spectra provides a feature to automatically identify the peaks and show their values on the 

graph. Here is the icon to show the peak values: 

 

Figure 14-67. Peak icon 

When pressed, the Peak button opens the Peak Information window: Peak Information window 

 

Figure 14-68. Peak Information window  
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Select Find and show peaks on the graph and set the Width of the peak searching window as well as a 

minimum value for the peak. Search for all wavelength regions with the set peak value search width and 

search the maximum value each time. If you increase the width of the search peak, the number of peaks 

to be searched will decrease. For the minimum value of the peak to be searched, set the lower limit of the 

peak to be searched. In this example, set the width to 50 nm and the minimum value of the peak to 30000. 

Click OK, and you will see the following result: 

 

Figure 14-69. The result of enabling Peak Information 

14-9-3. Print Preview and Print 

To print the current spectrum measurement, you can use the Print Preview or the Print icon on the 

toolbar. 

 
Figure 14-70. Print Preview icon         Figure 14-71. Print Preview icon 

The same window opens as Print and Print Preview from File menu (14-1-5. Page Setup and 

Print) .Pressing the Print Preview icon displays a standard Print Preview window, which shows the current 

spectrum measurement.  
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14-9-4. Set Integration Time Automatically 

When creating a spectrum measurement, you need to specify the integration time (sensor exposure time). 

If you do not know the integration time, first measure the spectrum with the default value (50 ms) and 

press Set integration time automatically icon on the toolbar, then SEC Spectra will automatically set the 

optimum integration time.  

 

Figure 14-72. Set integration time automatically icon 

 

Figure 14-73. The effect of using the Set integration time automatically icon 

The integration time has changed from 50 ms to 13 ms after the Set integration time automatically 

button is pressed. And the spectrum is corrected slightly downward.  
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14-9-5. Set as DarkSpectrum 

Set as dark spectrum icon is in the right of the Set integration time automatically icon. If you want to 

reset the dark spectrum, block the light source or disconnect the light source and press Set as dark 

spectrum icon. 

 

Figure 14-74. Set as dark spectrum icon 

14-9-6. FWHM 

SEC Spectra offers the function of displaying FWHM in real time. You can click the FWHM icon and click 

on any wavelength of the spectrum. The program will automatically find the highest peak nearby and 

measure its FWHM and reflect it in the spectrum. 

 
Figure 14-75. FWHM icon  
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14-9-7. Copy to Clipboard 

Sometimes you might want to copy and paste the spectrum data into other applications. You can do 

this by using the Copy to clipboard icon on the toolbar. 

 

Figure 14-76. Copy to clipboard icon 

As you press this icon, all data in the spectrum data pane will be copied to the system clipboard. You can 

then paste the data into the application you want. For illustration, we paste the data into Windows 

Notepad in the following figures: 

 

Figure 14-77. Pasting spectrum data into Windows Notepad  
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14-9-8. Close a Measurement 

To end the measurement such as spectrum, strip chart, absorbance, etc., you can close it by pressing 

the X icon on the upper right corner of the graph. 

 

Figure 14-78. The icon to close a measurement 

Note: When you close the graph, the measurement is also closed. If you need the same measurement 

later (such as spectrum), you need to create it again. 

14-9-9. Start Acquiring and Pause  

In most cases, SEC Spectra acquires data continuously from the spectrometer. Clicking the Save icon will 

activate the Pause icon and pause continuous acquisition. If you want to resume the measurement, press 

Start Acquiring icon to return to continuous acquisition. 

       
Figure 14-79. Start Acquiring icon and Pause icon 
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15. Spectrum Correction Features 

15-1. Electronic Dark Correction 

A basic electric current constantly flows through the electronic systems (such as the main board and 

the CCD sensor) of the BAS spectrometer whenever the spectrometer is on. This is called the "dark 

current," meaning this current exists even though no light enters the spectrometer. The analog-to-digital 

converter (ADC) will also convert this dark current into measurement readings across the entire 

spectrum, forming the baseline. Before shipment, BAS spectrometer will be factory-calibrated to an 

assumed baseline of 1,000 as the dark current. Since the dark current is not triggered by the light 

entering the spectrometer, this baseline needs to be deducted from the readings. As the level of the 

dark current can be affected by the device temperature, BAS has designed an algorithm to dynamically 

correct the readings in relation to the dark current. This is called the "electronic dark correction," a 

process which each BAS spectrometer must go through before shipment, and the correction data is 

directly stored within the spectrometer. When the electronic dark correction is enabled in the SEC 

Spectra software, the dark current will be dynamic removed from the measurement curve. The following 

figures show two different measurement curves without and with electronic dark correction, 

respectively: 

 

Figure 15-1. Without electronic dark correction  
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Figure 15-2. With electronic dark correction 

To enable electronic dark correction, click on the Electronic Dark Correction button above the toolbar. 

To disable it, just click on the button again. See the following figure: 

 

Figure 15-3. Electronic Dark Correction icon  
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15-2. Linearity Correction  

The response curve of the CCD sensor in relation to the light intensity is not a perfect straight line. In 

addition, the response curve of each CCD sensor will not be identical to each other. For this reason, each 

BAS spectrometer will go through a "linearity correction" process before it is shipped, with its own 

correction table store within the spectrometer. As BAS spectrometer uses a 16-bit ADC internally, its 

output readings will be calibrated to the range between 0 and 65535. When linearity correction is 

enabled in the SEC Spectra software, the reading for each pixel will be corrected using this table. See the 

following figure for the difference: 

 
Figure 15-4. Without linearity correction 

  

Figure 15-5. With linearity correction 

To enable linearity correction in SEC Spectra, click on the Linearity Correction icon above the toolbar. 

To disable it, just click on the button again. See the following figure: 

 

Figure 15-6. Linearity Correction icon 
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16. Contact Information 

This concludes our introduction to all features of SEC Spectra. Hopefully, these chapters will help you 

get up to speed with SEC Spectra as a new user. If you have any further questions about SEC Spectra or 

any suggestions to this guide, please contact us at:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Manufactured by:  ALS Co., Ltd 

 

Exclusive distributor:  BAS Inc. 

 
Address: 1-28-12, Mukojima, Sumida-ku, Tokyo 131-0033, JAPAN 

Phone: +81-3-3624-0331 
Fax: +81-3-3624-3387 

https://www.als-japan.com 
email: sales@als-japan.com 
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